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Important

® The following functions are for reference only. Some series products may not
support all the functions listed below.

® Usually we recommend IE 7 or higher version. For those versions below IE 7, it
may not support the operation of some functions.
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1 Network Connection

1.1 Preparation

This series speed dome product supports the Web access and management via PC.

Web includes several modules: monitor channel preview, PTZ control, system configuration, alarm and

etc.

Please follow the steps listed below for network connection.

® Make sure the speed dome has connected to the network properly.

® Speed dome IP address and PC IP address shall be in the same network segment. If there is router,
please set the corresponding gateway and subnet mask.

® Use order ping *x* *»** **x x*x(* gneed dome address) to check connection is OK or not.

1.2 Login

Open IE and input speed dome address in the address bar.
For example, if your device IP is 192.168.1.108, then please input http:// 192.168.1.108 in IE address
bar. See Figure 1-1.

‘€ Blank Page - Windows Internet Explorer g@
o3 2

- |ie] sboltbank

A

Input your IP
m-o & oee-ows. || address here

W & | @ sankpage

€ Internet H100% T

Figure 1-1
The login interface is shown as below. See Figure 1-2.
Please input your user name and password.
Default factory name is admin and password is admin.
Note: For security reasons, please modify your password after you first login.
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Usemame:  admin

Password: |

Login Cancel

Figure 1-2
If it is your first time to login in, system pops up warning information to ask you whether install control
webrec.cab or not. Please click OK button, system can automatically install the control. When system is
upgrading, it can overwrite the previous Web too.
If you can’t download the ActiveX file, please check whether you have installed the plug-in to disable the
control download. Or you can lower the IE security level. See Figure 1-3.

Option Security Settings - Internet Zone [X,I
General | Security |Privacy Content | Connections | Programs | Advanced Settings
(O Disable A
Select a zone ko view of change security settings. @ Enable
. F \#| Download signed ActiveX controls (not secure)
0 .g L' 4 B ) Disable
Internet Lacal inkranet Trusted sites % (%) Enable (not secure)
< | pd ) Prompt {recommendad) B
Internet - \#| Download unsigned ActiveX controls (not secure)
@ This zone is for Internet websites, = () Disable {recommendad)
except those listed in trusted and

(%) Enable (not secure)
O Prompt
\#| Initialize and script Activei controls not marked as safe for s
() Disable {recommended)
(%) Enable (not secure)

restricted zones,

Security level For this zone

Allowed levels For this zone: Medium ko High

- | - Medium-high ) Prampt
N - - Appropriate for most websites . )
Lrl - Prompts before downloading potentially unsafe || Pun Actives: controls and plug-ins 2
= 5 content (7Y hArsirickeskar ammeauad =
- Unsigned Activel contrals will not be downloaded <_ | z
*Takes effect after vou restart Internet Explorer
Default level Reset customn setbings
Reset b0 | Medium-high (deFault) v| [ Res. |
Reset all zones bo default level
I O l [ Cancel ]

O H Cancel ][ Apply
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Figure 1-3

1.3 Live Interface

After you logged in, you can see the live monitor window. Now you can operate the speed dome via the
WEB. See Figure 1-4.
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Figure 1-4

There are six sections:

Section 1: Encode setup bar

Section 2: Window adjust bar

Section 3: System menu bar

Section 4: Window function option bar
Section 5: PTZ control

Section 6: PTZ function

1.4 Encode Setup

The encode setup interface is shown as in Figure 1-5.
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| biain Sream | Sub Stream 1 Sub Stream 2 Rl TCP IEI

Figure 1-5
Please refer to the following sheet for detailed information.

Parameter Function

In normal network width environment, main stream can record
audio/video file and realize network monitor.

Sub Stream 1 Connected to the Protocol, monitor or close the video under sub
stream 1 configuration. It can be used for network monitoring
instead of main stream when network bandwidth is not sufficient.
Connected to the Protocol, monitor or close the video under sub
stream 2 configuration. It can be used for network monitoring
instead of main stream when network bandwidth is not sufficient.
You can select video monitor protocol from the dropdown list.
There are three options: TCP/UDP/Multicast.

Main stream

Sub Stream 2

Protocol

1.5 Video Window Setup

The interface is shown as in Figure 1-6.

1 23 45 6 7

W ooy 32 +o ER

Figure 1-6
Please refer to the following sheet for detailed information.
SN Parameter | Function
1 Image Click it to show or hide picture setup interface. See Figure
adjustment 1-7. This interface is on the top right pane.
2 Original Click this button to go to original size. It is to display the actual
size size of the video. It depends on the resolution of the video.
3 Full screen | Click it to go to full-screen mode. Double click the mouse or
click the Esc button to exit the full screen.
4 Width and Click it to restore original ratio or suitable window.
height ratio
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5 Fluency There are three types: real-time/normal/fluency.
setup
6 Rules info Click it to enable live interface to display intelligent rules,
default is enable.
7 Open/close | Left click it to display or hide the PTZ control interface.
PTZ
interface

The picture setup interface is shown as in Figure 1-7.

Image Adjustment

Figure 1-7
Please refer to the following sheet for detailed information.
Parameter Function
Video | pg% Brightness setup icon. It is to adjust | Note:
setup monitor video brightness. ® All the operations here

Contrast setup icon. It is to adjust
monitor video contrastness. °

apply to WEB end
only.
Please go to Setup-

a Saturation setup icon. It is to adjust
monitor video saturation.

>Camera->Conditions
to adjust brightness,
contrast, hue and

H Hue setup icon. It is to adjust saturation setup.
monitor video hue.

Reset | Restore brightness, contrastness
saturation and hue to system default
setup.

1.6 System Menu

System menu is shown as in Figure 1-8.
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Please refer to chapter 1.3 Live, chapter 2 Playback, chapter 3 Setup, chapter 4Alarm, chapter 5 Log

out for detailed information.

Figure 1-8

1.7 Video Window Function Option

The interface is shown as below. See Figure 1-9.

2 3456728910 11
/

1

Figure 1-9
Please refer to the following sheet for detailed information.
SN Parameter Function
1 Remark Click it and then select pen color, you can write down the
mark information on the preview interface.
2 Gesture On the preview interface you can left click mouse to control
control the PTZ and use the middle button to zoom in/zoom out.
3 Alarm Click it to generate an alarm output and the button becomes
output red. Click it again to stop alarm output.
There are two alarm output icons since this series product
supports two relay output.
Please note the alarm output interface may vary due to
different series products.
4 Digital When video is in original status, click this button you can
zoom select any zone to zoom in. After zoom in ,you can drag the
zoom in area in the specified area. Right click mouse system
restores original status. You can use the wheel to zoom out
the video.
5 Snapshot You can snapshoot important video.
You can go to Setup->Camera->Video->Path to modify the
local record save path.
6 Triple snap Click it, system can snap at 1f/s for three times. All images
are memorized in system storage folder.
7 Record When you click local record button, the system begins
recording.
You can go to Setup->Camera->Video->Path to modify the
local record save path.
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8 Manual Click it and then left click the mouse and drag the mouse in
Track the video window to select any zone, you can enable the
speed dome to auto track the object in the specified area.

Please note, you need to go to the Setup->IVS setup->Global
setup interface to enable IVS auto track function. Otherwise,
this function is null.

9 Audio Turn on or off audio when you are monitoring.
output You can go to Setup->Camera->Audio to set.

10 Bidirectional | Click it to begin audio talk. You can go to Setup->Camera-
talk >Audio to set bidirectional talk mode.

11 Help Click it to open help file.

1.8 PTZ Control

Before PTZ operation, please make sure you have properly set PTZ protocol. (Please go to Setup-

>System->PTZ to set.).

Here you can view direction keys, speed, zoom, focus, iris button. See Figure 1-10.

® PTZ direction: PTZ supports eight directions: left/right/up/down/upper left/upper right/bottom
left/bottom right/ fast positioning.

® Speed: The step 8 speed is faster than step 1.

Figure 1-10
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1.9 Joystick

Figure 1-11

The function of joystick can be simulated by dragging the button in the middle, which can be used to
control the device rotation.

1.10PTZ Setup/Menu

The PTZ setup/Menu interface is shown as in Figure 1-11.

PTZ Settings Menu

Figure 1-11
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Click PTZ set button, the interface is shown as in Figure 1-12.Here you can select scan, preset, tour
pattern, assistant function and etc.

PTZ Settings Menu

Fattern

Scan
Freset
Taur

Assistant
Light Wiper
ioto

Fan

Figure 1-12

Please refer to the following sheet for PTZ setup information.

Parameter | Function

® Select Scan from the dropdown list, click Set button and then
control the PTZ to set the scan left limit and right limit. Start
button, you can begin scan operation. Default SN is 1.

® Select Preset from the dropdown list, input the preset value and
then click Add button, now system save current position as one
preset. Click View button, the camera turns to the corresponding
position of the preset.

® Select Tour from the dropdown list and then input tour value.
Click Add or Delete button to add/remove one preset from the
tour. Click Start button, you can begin tour.

® You can select Pattern from the dropdown list and then click
Add button, now you can operate PTZ to realize zoom, focus,
iris, direction operation and etc. Click Stop button to stop
memory pattern process. Click Start button to begin PTZ
movement.

® Input assistant value and click AUX on button to enable
corresponding assistant value. Click AUX off button to disable
assistant function.

Scan

Preset

Tour

Pattern

Assistant
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Parameter | Function
Goto ® |tis the accurate positioning function. Please input
corresponding horizontal angle, tilt angle, and speed dome
zoom speed and then click Goto button to go to a specified
position.
® One unit of the horizontal angle or tile angle stands for 0.1
degree.
Pan Select Pan from the dropdown list and then click Start button, you
can turn the PTZ realize 360 degrees movement. Click Stop button
to stop current operation.

10
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2 Playback

The playback of WEB client end supports two modes which are video playback and picture playback.

Note:

It needs to set “3.5 Storage Management” before operating playback.

2.1 Video Playback

The video playback interface of WEB client end includes the following six functions:

Parameter

Note

Play function

Playback file

Playback clip

Record type

Progress bar

o | 0| R WDN|F

Aux function

00000 O = CIKEEEITETD
0 1 2 3 4 5 6 4 8 9 20 P 22 23 24

Stop

em®
File Type
[S=EESN SD Card B
< I
Sun Mon Tue Wed Thu Fri Sat
1]2]3]afs]s]7

8lojof11j12{13]14
15,1617/ 18 19120 21

22(23) 24 25| 26| 27 28

29 130 31

E

10 11 12 3 14 15 16 17 18 19

Record Type B1 Al Bl Gonera B Moion B Aam 1 Marwal [Qaine] Oz | Qi | Ot

Figure 2-1

11
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2.1.1 Play Function

Qoooo o o

Figure 2-2

Parameter Note

When it displays this button, it means stop playing or not playing video. Click it to
@© Play ; .

switch to normal playing status.

@ Stop Click it to stop playing current video.

Click it to play next frame.
® Next frame Note:

It needs to pause playback when using next frame function.
@ Slow Click it to make it play slowly.
® Fast Click it to make it play fast.
® Quiet It is mute when it displays this button, Click it to restore audio function.
@ Volume Click the left mouse button to adjust the playback volume.

2.1.2 Playback File
The blue date in the calendar means that there is video or snapshot file on the current day.

12
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Figure 2-3

Parameter Note

e Select “dav” to playback video.

File type - i
e Select “jpg” to playback picture.
Data source The default is SD card.
Step 1

Click the blue date, the time line will display the record file progress bar with colors. Green represents
general record; yellow represents motion record; red represents alarm record; blue represents manual
record.

Step 2

Click a certain time location of the record file progress bar area, the playback interface will play the
record file from that time.

Figure 2-4
Step 3
Click file list #= ", the record file of selected date will display in the list.
Step 4

13
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Double click the file in the list, and it will playback the file, meanwhile it will also display file size, begin

time and end time.

00:00: 00 - 23 : 59 : 59 @
Dt iFormat & dav @ mp4
Start Time Record Type

13:33.57

13:40:55

13:41:17

134155

134215

13:43:01

13:43:22

M<11> M coTo I

Begin Time:
End Time:

File Size:

Figure 2-5
Parameter Note
E It is to search all the record file between begin time and end
Search time of the selected date.
Download :
Format Two formats to select: dav and mp4.

14
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Parameter Note
e When record type is “dav’, click download button to download the file to
local.
e When record type is “mp4”, click download button to download file to 3.1.15.
m Download Storage path.
Note:
The system doesn’t support download and playback record of MP4 format at the
same time.
€ Back Click it to go back to calendar interface to select date again.

2.1.3 Playback Cut

Note:

When using playback cut function, the record file which is being playbacked will stop playing
automatically, which means that playback cut and playback can’t be done at the same time.
Step 1

Click the begin time of playback cut on the timeline, and the time needs to be within the range of
progress bar area of the record file.

Step 2

—_—

Move the mouse to the top of the clip icon 5’5 , it will display “Select Begin Time” on the lower right

corner. Click cut icon 5;5 , and finish the setting of begin time of playback clip.

Step 3

Click the end time of playback cut on the timeline, and the time needs to be within the range of progress
bar area of the record file.

Step 4

_—

Move the mouse to the top of the cut icon ; it will display “Select End Time” on the lower right

corner. Click cut icon Eﬁ , and finish the setting of end time of playback cut.

Step 5
Click “Save” to edit the file to 3.1.1.5 storage path.

00:00:00 - 00:00:00 m

Figure 2-6

15
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2.1.4 Record Type
After checking record file type, it will only display the selected type of file in the progress bar and file list.

Record Type All General Motion Alarm Manual 1

Figure 2-7
2.1.5 Progress Bar Time Format

Oztr | @i | Oz0min

Figure 2-8

Parameter Note

24 hour button | Click the button and the progress bar will display in 24-hour mode.

O 2hr Click the button and the progress bar will display the record file within 2
2 hour button hours range.
O 1hr Click the button and the progress bar will display the record file within 1
1 hour button hour range.
. Click the button and the progress bar will display the record file with30
©:30min }30 min button

minutes range.

2.1.6 Aux Function

Figure 2-9

Parameter Note

e Click the button to select any area to zoom when the playback video
is in the original state, it can drag and zoom the area in a certain
range when it is in the non-original state, click the right mouse button
to restore the original state.

-: Regional Zoom

e Click the button and zoom the image size by rolling the mouse wheel.

E Click the button and snapshot the playback video, the image will be
Snapshot stored in the path 3.1.1.5.

16
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2.2 Picture Playback

The picture playback interface of WEB client includes following three functions.

Parameter Note

1 Play function
2 Playback file
3 Snapshot type

File Type T34 [~]

[BEE SD Card |~

q o B
Sun Mon Tue Wed Thu Fri Sat
1 213J4)5])6]7
8191011112113 14
1516 17 1819 20 21

2|2 (2] 52| 27|28

29130 ) 31

Snapshot Type Al General | Motion B Alarm

Figure 2-10

2.2.1 Play Function

17
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Figure 2-11

The default icon is m which means stopping playing or not playing pictures.

Click play button and switch to normal play state, at this moment, the icon displays as m

Click pause button and switch to pause play state.

2.2.2 Playback File

File Type [0 [+]

Sun Mon Tue Wed Thu Frni Sat

Figure 2-12

18
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00 : 00 : 00 - 23 : 59 : 59 jfe}

Start Time File Type

O
(3
(3
(3
(3
(3
(3
(3]
(3

<11 » pi D

Figure 2-13

Step 1

Click file list =
Step 2
Double click the file in the list, it will playback the snapshot picture.

, the snapshot file of selected date will display in the list.

Parameter Note
E It is to search all the snapshot file between begin time and end
Search time of the selected date.

m Download Click “Download” button and download the snapshot file to local.

rs

Back Click it to go back to calendar interface to select time again.
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2.2.3 Snapshot Type
After checking snapshot type, it will only display the selected type of file in the file list.

Snapshot Type All General Motion Alarm

Figure 2-14

20
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3 Setup

3.1 Camera

3.1.1 Video
3.1.1.1 Video bit stream
The video bit stream interface is shown as below. See Figure 3-1.

@Jhua
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Camera

> Audio
IVS Setup
Network
Event
Storage

System

Information

Video Snapshot

Main Stream Sub Stream

Enable Sub Stream 1 =]
Code-Stream Type | General [+ Code-Stream Type | General =]
Encode Mode H.264H [~] Encode Mode H.264H =]
Resolution 1080P (1920*1080) E Resolution D1 (704*576) E|
Frame rate(FPS) 25 [=] Frame rate(FP3) 25 =]
Bit Rate Type CBR [=] Bit Rate Type CBR =]
Reference Bit Rate  1024-8192KbiS Reference Bit Rate  224-4096Kb/S
Bit Rate 4096 [=] Bit Rate 384 =]
| Frame Interval 50 (25~150) | Frame Interval 50 (25~150)
Ve 1(off) [~ sve 1(off) =
Watermark Settings
Watermark Character | DigitalCCTV

Default__ [ Refresh || saw

Figure 3-1
Please refer to the following sheet for detailed information.
Parameter Function
Main Bit stream type It includes general stream, motion stream and alarm

stream

stream. You can select different encode frame rates for
different recorded events.

The frame rates of the motion detect and alarm is
customized.

Encode mode

There are four options: H.264, H.264H, and MJPEG
encode mode.

H.264 : Main Profile encode mode.

H.264H: High Profile encode mode.

MJPEG: In this encode mode, the video needs
general large bit stream to guarantee the video
definition. You can use the max bit stream value in
the recommend bit to get the better video output
effect.

21



@h

iaua Dahua Network Speed Dome Web 3.0 Operation Manual
Parameter Function

Resolution There are multiple resolutions. You can select from the
dropdown list.
For each resolution, the recommended bit stream value
is different.

Frame Rate PAL: 1~25f/s, NTSC: 1~30f/s.

(FPS)

Bit Rate Type

There are two options: VBR and CBR.

Please note, you can set video quality in VBR mode.
In MJPEG mode, the bit stream control mode can only
be CBR.

Recommended
Bit

Recommended bit rate value according to the resolution
and frame rate you have set.

Bit Rate

¢ In CBR, the bit rate here is the average value. Usually
it goes up and down between 10%.

¢ |t is the max value in VBR mode. When the scene is
not complicated, the bit value may be lower than you
set.

| Frame

Here you can set the P frame amount between two |
frames. The value ranges from 1 to 150. Default value
is 50.

Recommended value is frame rate *2.
Important

| frame interval setup is null if it is the MJPEG
encode mode.

SvC

Frame rate can be encoded by layer. It is a flexible
encoding method. By default, itis 1 as 1 layer. You also
can set 2/3/4 layers.

Watermark

This function allows you to verify the video is tampered
or not.

The max length is 128-digit. The character can only
include number, character, underline and hyphen.

Sub
stream

Sub Stream
Enable

If check the enable box here to enable or disable sub
stream, it is enabled by default.

It supports enable two sub streams at the same time:
sub stream 1, sub stream 2.

Bit stream type

General bit stream.

22
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Parameter

Function

Encode mode

There are four options: H.264, H.264H, and MJPEG
encode mode.

® H.264 : Main Profile encode mode.
® H.264H: High Profile encode mode.

® MJPEG: In this encode mode, the video needs
general large bit stream to guarantee the video
definition. You can use the max bit stream value in
the recommend bit to get the better video output
effect.

Resolution

There are multiple resolutions. You can select from the
dropdown list.

For each resolution, the recommended bit stream value
is different.

Frame Rate
(FPS)

PAL: 1~25f/s, NTSC: 1~30f/s.

Bit Rate Type

There are two options: VBR and CBR.
Please note, you can set video quality in VBR mode.

Recommended
Bit

Recommended bit rate value according to the resolution
and frame rate you have set.

Bit Rate

* In CBR, the bit rate here is the average value. Usually
it goes up and down between 10%.

¢ |t is the max value in VBR mode. When the scene is
not complicated, the bit value may be lower than you
set.

| Frame

Here you can set the P frame amount between two |
frames. The value ranges from 1 to 150. Default value
is 50.

Recommended value is frame rate *2.
Important

| frame interval setup is null if it is the MJPEG
encode mode.

Frame rate can be encoded by layer. It is a scalable
encoding method. By default, itis 1 as 1 layer. You also
can set 2/3/4 layers.

3.1.1.2 Snapshot

The snapshot interface is shown as in Figure 3-2.

23
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EQLUE]

Video Snapshot

P o a
> Audio .
Image Size
IVS Setup B
Quality 5
Network
Interval 18
Event E
Storage Defeutt || Refiesh || Sawe
System
Information

Figure 3-2

Please refer to the following sheet for detailed information.

Parameter Function

Snapshot type There are two modes: general (schedule) and Event

(activation).

General (schedule) snapshot is to snap in the specified period.

Event (Activation) snapshot Is to snap when the motion detect,

camera masking, local alarm event occurrence.

If you want to use this function, please make sure:

® The event occurred during the specified period.

® Motion detect, video masking, local alarm and
corresponding snap function are all enable.

Image size It has relationship with the resolution of the main stream.
Quality It is to set the image quality. There are six levels.
Interval It is to set snapshot frequency. The value ranges from 1s to 7s.

3.1.1.3 Video Overlay
The video overlay interface is shown as in Figure 3-3.

Snapshot

L B Ja——— » ChanelTite [CRE T ON )
> Audio d ’ —([=

» Time Title Input channel title:
IVS Setup

» OSDinfo IP PTZ Dome
Network
_— » Picture Overlay
Storage

System

Information

[ Defaut | Refresh | sae

Figure 3-3
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> Audio
IVS Setup
Network
Event
Storage
System

Information

> Audio
IVS Setup
Network
Event
Storage
System

Information
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Path

» Channel Title @ Enable () Disable

» OSDinfo

» Picture Overlay

i

ey, ¢

IPDome

Snapshot

» Channel Title Text Overlay: () Enable @ Disable
» Time Title

Input Text:
» Picture Overlay
Text Align
Right [~]

[ Default || Refresh || Save |

Figure 3-5
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Enable © Disable

» Channel Title

» Time Title Picture Preview:
IVS Setup

St [ y » OSDinfo
Event
Storage

System

Information

Requirement for picture upload

1. Max size is 64k.

2. Max resolution is 128x128 pixels.
3. 8 bits, bmp format.

Figure 3-6

Parameter | Note

¢ Check “Enable”, then it will display channel title in the video monitoring window;

Channel check “Disable”, then it won't display.

Title
* You can use the mouse to drag the “Channel Title” box to adjust its position.

e Check “Enable”, then it will display time title in the video monitoring window;
Time Title check “Disable”, then it won'’t display.

* You can use the mouse to drag the “Time Title” box to adjust its position.

e Check “Enable”, then it will display OSD in the video monitoring window; check
“Disable”, then it won’t display.

OSD Info
* You can use the mouse to drag “OSD Info” box to adjust its position. Alignment
mode includes left align and right align.
e Check “Enable”, then it will display picture overlay in the video monitoring window;
check “Disable”, then it won’t display.
Picture e Click it to upload picture, and it can overlay local picture into the video monitoring
Overlay window. You can drag the yellow box to adjust the position of overlaid pictures.
Note:
OSD Info and Picture Overlay can’t be enabled at the same time.
After setting Channel Title, Time Title, OSD Info and Picture Overlay and saving
Refresh o
successfully, you can check the results by clicking refresh button.
3.1.1.4 ROI
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Snapshot

_ © Enable

) Disable
> Audio

IVS Setup
Network

Image Quality |6(best) [~]

Event
Storage
System
Information

IPDeme
Remove All Delete (Or Rightclick )
\ Default ‘ | Refresh | i Save 1

Figure 3-7

Parameter | Note

Check “Enable” to display ROI in the video monitoring window; check “Disable” not to

Enable display.
Image It can set the image quality of ROI, ranging from 1~6.
Quality

3.1.1.5 Path
The storage path interface is shown as in Figure 3-4.

Video Snapshot

. ot Live Snapshot C\Documents and Settings\AdministratorWWebDowr
> Audio

Live Record C:\Documents and Settings\AdministratorVWebDowr
IVS Setup
Playback Snapshot C:\Documents and Settings'\Administrator\VVebDowr
Network
Event Playback Download ~ C:\Documents and Settings\AdministratorWWebDowr
Video Clips C:\Documents and Settings\Administrator\VWebDowr
Storage
System Defaut || saw

Information

Figure 3-4

Storage path and the snapshot, record linkage in the live interface can set the storage path for
monitoring snapshot and monitoring record respectively.
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Storage path is linked to snapshot, download and clip in the playback interface, which can set the
storage path for playback snapshot, record download and playback clip respectively.

e Default Live Snapshot path: C:\Documents and
Settings\Administrator\WebDownload\LivePicture

e Default Live Record path: C:\Documents and Settings\Administrator\WebDownload\LiveRecord

e Default Playback Snapshot path: C:\Documents and
Settings\Administrator\WebDownload\PlayBackPicture

e Default Playback Download path: C:\Documents and
Settings\Administrator\WebDownload\PlayBackRecord

e Default Playback Clip path: C:\Documents and
Settings\Administrator\WebDownload\PlayBackRecordCut

Note:

Administrator is the PC account with local login.

3.1.2 Audio

The audio interface is shown as below. See Figure 3-5.

Important

Please make sure you have enabled the video function, otherwise you can not enable the audio
function.

@hua

Encode

Sub Stream

[C] Enable Sub Stream 1
IVS Setup

Network

Encode Mode G.711A Encode Mode G.T11A

Event

Storage

System

Information
Figure 3-5

Please refer to the following sheet for detailed information.

28



alhua

TecHwoLoor Dahua Network Speed Dome Web 3.0 Operation Manual

Parameter

Function

Audio enable

® Main stream: Recorded file only contains video by default.
You need to check the audio box here to enable audio
function so that the main stream the network transmitted is
audio/video composite stream.

® Sub (Extra) stream: Recorded file only contains video by
default. You need to check the audio box here to enable
audio function so that the extra stream the network
transmitted is audio/video composite stream.

Encode mode

The encode mode of the main stream and extra stream include
PCM, G.711A and G.711Mu.

The setup here is for audio encode mode and the bidirectional
talk encode both.

3.2 IVS Setup
3.2.1 Global Setup

The global setup interface is shown as in Figure 3-6.

QLUE

Camera Global Setup

IVS Setup

Network

IVS Setup

VS Enable

Event Apply Scence
Storage Alarm Track Enable
System Scene Type
Information

Dejitter Rate

Rate

Distance:

Dejitter Enable

Tracking Overlap

Valid Tracking

Scene Setup Parameter

Rule Setup

Panorama PTZ

Panorama PTZ enable

Normal E

single Scene [+]

O 50

(0-100)

10 (0-100)

Valid Tracking Time 10 (0-100)

Refiesh || Ssave

Figure 3-6
Please refer to the following sheet for detailed information.
Parameter Function
IVS enable Check the box here to enable VS function.
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Parameter

Function

Panorama PTZ
enable

Click it to enable panorama PTZ.
Note:

IVS function and panorama PTZ can’t be enabled at the same time.

It includes: panorama, single scene and multiple-scene.

¢ Panorama: Realize the intelligent analytics of current monitor video after you
enabled the preview function.

Scene type ¢ Single scene: Realize the intelligent analytics of one scene.

¢ Multiple-scene: It is to realize the intelligent analytics of several scenes and the

scenes support tour function.

Appply scene The default setup is normal.

Check the box here to enable this function. System can begin auto track function
Alarm track . ; SO .

once arule is activated. The alarm track function is null if you do not check the box
enable ; o

here. It does not affect other alarm output when this function is null.
De-jitter Here you can set device de-jitter rate.

De-jitter enable

Check the box here to enable de-jitter module.

3.2.2 Scene Setup
The scene setup is shown as in Figure 3-7.

@Jhua

Camera
IVS Setup
Network
Event
Storage
System

Information

v [ pamack [ s | aam [ togoun

Global Setup Rule Setup Parameter @

Scene Single Scene
Track Time(s) Limit Track Delete
30 L] =
Scene2 30 | e
Scene3 30 I~ (-}

I Add Scene H Scene Setup || Preview Scene I

Scene Track Setup and Get

@® =n @ i N e w—

O tontine  [azepal i) Rioitine pecizal mitzal

Refresh I | Save |

Figure 3-7

Please refer to the following sheet for detailed information.
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Parameter

Function

Add scene

Click it to add a scene.

Scene setup

Click it to set current monitor video as the corresponding scene and get a number.

Preview scene

Click it to preview the selected scene.

Check the box here, you can set up/down/left/right limit at the bottom of the

Limit Track interface.

Zoom Click ® to zoom in and click @ to zoom oult.

PTZ Click PTZ button g to adjust scene position.

Speed It is to set PTZ movement speed. The value ranges from 1 to 8.

3.2.2.1 Single Scene
In Figure 3-6, select the single scene from the scene type list, you can see the single scene interface is

shown as in Figure

3-8.

Here you can select one item from the No. list to view one monitor scene.

@hua

Camera
IVS Setup
Network
Event
Storage
System

Information

Global Setup

Single Scene

NO. Scene Name
1
2
3

Scene1
Scene2
Scene3

SceneSetup, ‘ l Preview Scene |

Scene Track Setup and Get

| Refresh ‘ \ Save |

Figure 3-8

3.2.2.2 Multiple-scene track
In Figure 3-6, select the Multiple-scene from the scene type list, you can see the multiple-scene
interface is shown as in Figure 3-9.
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@Jhua

Camera Global Setup
IVS Setup

Lowvs

Scene Setup Rule Setup Parameter

Scene Muiti-scene
NO. Scene Name Stay Time(s) Delete

Network 1 30 e
Event 2 Scene2 30 -
Storage 3 Scene3 30 =]
System
Information
e
! Add Path | | SceneSetup, | | Preview Scene l

o Scene Track Setup and Get
Zop SetiiackRate
o Speed| 5 & LeftLine L

| Refresh l

w
5

Figure 3-9

In Figure 3-9, click Add scene button you can set tour point during the scene tour process. Move the
mouse to the Scene name list; you can select several scenes as a tour. Move the mouse to the Stay

time, you can set stay time period.

3.2.3 Rule Setup

The rule setup interface is shown as in Figure 3-10.

@Jhua

Camera

Network

Event

Storage

System

Information

Global Setup

Scene Setup

Rule Setup

1005 BEIRET T

Select Scene | Scene2 [~]
[Enable SN Rule Name Rule Type Draw Delete

vl q Scene2_1 Intrusion =)

Intrusion
Abandonde
Loitering Detection

Fast Moving

Perimeter Protection
Missing Object Detection
lllegal Parking

Alarm Activation Setup
Parameter Setup Rule Working Period
Object Type Supported Direction Enter  [+] [] Record
Detect Action List M Taroet o 7] Relay-out [ 2
[ InArea MiTa gt o [] Send Email
@ Through Min Last Time. (s) [F1 Snapshot
Report Interval

" © Copy To ALL E

] Target Fiter Draw | | Clear |
Min Size 0 Max Size & 9
Refresh Save

Figure 3-10
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Please refer to the following sheet for detailed informaiton.

Parameter Function

You can select the scene from the dropdown list so that you can add the
Select scene. .

corresponding rule.
Add rule Click it to add a rule to the selected scene.
Rule enable Check the box here to enable the rule.
Rule name Move you mouse to the rule name column to set a name.

Move you mouse to the Rule type column to set the rule type. The option includes:
Rule type Lo .

Tripwire/Cross warning zone.
Draw rule Click button /] to draw current rule.

=N

Delete rule Click button ™ to delete current rule.

3.2.3.1 Tripwire

The tripwire interface is shown as in Figure 3-11.

Global Setup Scene Setup Rule Setup Parameter @
7 B Select Scene | Scene2 E]
§ | V] Scene2_1 Tripwire % o -
Event
Storage
System
Information
Area and Property Setup Alarm Activation Setup
Parameter Setup Rule Working Period Setu
Object Type Supported @) Record !
Direction A>B  [+]
[v] Relay-out E] 2
[¥] Target Filter Draw | [ Clear | [ Send Email
Min Size Max Size (] Snapshot
Copy To| ALL E|
Refresh “ Save
Figure 3-11
Please refer to the following sheet for detailed informaiton.
Parameter Function
Object e . .
supj)ported typ You can select an object type here. The default setup is all types.
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Parameter

Function

Direction

It is to set tripwire direction. The option includes: A->B. B->A. A<->B.

Target filter

Check the box here to enable this function and then click button Diaw ,» you can

set the target filter model in this scene for this rule. Click the button Ciear , you

can remove selected target filter model.

3.2.3.2 Cross Warning Zone
The cross warning zone interface is shown as in Figure 3-12.

@Jhua

Camera

Storage

System

Information

Global Setup Scene Setup Rule Setup Parameter @

Select Scene | Scene2 E\
! NEnable Rule Name RuleType  Draw Delete

v 1 Scene2 1 |Intrusion [~ o

ip
Intrusion
Abandonde

Loitering Detection

‘Fasl Moving

Perimeter Protection
‘Mlssing Object Detection
|llegal Parking

Avea and Property Setup Alarm Activation Setup
Parameter Setu| Rule Working Perio
Object T':Pe S:P:’“‘e" Direction Enter  [~] Z'R‘:’Co’; e
Detect Action List Max Target Ho [v] Relay-out W2
] InArea Min Target No. [] Send Email
@ Through Min Last Time (s) ) Snapshot
Reponilnlerval (s) CopyTo|ALL =]
[¥] Target Filter Draw | | Clear
Min Size * Max Size
Figure 3-12
Please refer to the following sheet for detailed informaiton.
Parameter Function
Object e . .
supj)ported P You can select an object type here. The default setup is all types.

Detect action
list

® In area: When the tracking object is in the detect zone and the stay time is
more than the time threshold you set here, system can activate an alarm.

e Through area: System can generate an alarm when the tracking object is
crossing the limit you set here.

Direction

It is for the Through area option in the Detect action list item. It is to set the cross
direction. The option includes: infout/both (in&out)
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Parameter Function

amount in the zone is more than the threshold you set here.

It is for the In area option in the Detect action list item. It is to set the alarm
Max target No. | activation amount in the zone. System will not generate an alarm when the object

amount in the zone is less than the threshold you set here.

It is for the In area option in the Detect action list item. It is to set the alarm
Min target No. activation amount in the zone. System will not generate an alarm when the object

Min last time between the target in the zone and an alarm activation occurrence.

It is for the In area option in the Detect action list item. Here is to set the min time

Report interval System just alarms once if the value is 0 here.

It is for the In area option in the Detect action list item. It is to set alarm period.

Draw

Target filter

Clear

selected target filter model.

Check the box here to enable this function and then click button , you can

set the target filter model in this scene. Click the button » you can remove

3.2.3.3 Abandoned Object Detection
The abandoned object detection interface is shown as in Figure 3-13.

Rule Setup

NetaoT Enable SN Rule Name Rule Type __Draw Delete
TIEE Scene2 1 Abandonde 4 o -

Event

Storage &
System - Sco P
Information

Alarm Activation Setup

Parameter Setup Rule Working Period
Object Type Supported ] Record
Min Last Time 6 (s) —
[9] Relay-out (2
[V] Target Filter Draw [ \ Clear O Send Emai
Min Size . Max Size £ [ Snapshot

Copy To |ALL [~]

Figure 3-13

Please refer to the following sheet for detailed informaiton.
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Parameter

Function

Object
supported

type

You can select an object type here. The default setup is all types.

Min last time

It is to set the min time between the abandoned object occurrence and alarm

activation.

Target filter

Check the box here to enable this function and then click button

set the target filter model in this scene. Click the button
selected target filter model.

Clear

Draw

, you can

» you can remove

3.2.3.4 Loitering Detection
The lointering detection interface is shown as in Figure 3-14.

Storage
System

Information

Area and Property Setup

Rule Name

e

Scenel_1

Rule Type Draw Delete
Loitering Detection ¢ o ~

Alarm Activation Setup
Parameter Setu Rule Working Period Setu
Object Type Sup::oned 7 R ?
Alarm Activation iy
No.(Person) [@] Relay-out [l [ 2
Min Last Time 5 (s) | Send Email
Report Interval 0 (s) [C] Snapshot
[V] Target Filter Draw [ | Clear CopyTolALL El
Min Size Max Size
Refresh H Save
Figure 3-14
Please refer to the following sheet for detailed informaiton.
Parameter Function
Object e . .
) P You can select an object type here. The default setup is all types.
supported
Alarm
activation I .
number Here you can set the alarm activation threshold. The default setup is 0.
(Person)
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Parameter

Function

Min last time

Here is to set the min time between the target in the zone and an alarm activation
occurrence.

Report interval

It is to set alarm period. System just alarms once if the value is O here.

Check the box here to enable this function and then click button Diaw » you can
Target filter _ o _ Clear
set the target filter model in this scene. Click the button » you can remove
selected target filter model.
3.2.3.5 Fastl Moving
The fast moving interface is shown as below. See Figure 3-15.
@Jhua
Camera Global Setup Scene Setup Rule Setup
. P I Select Scene| Scenet E
| ‘NEnable SN Rule Name RuleType  Draw Delete

Event

Storage

System

Information

IR | Scenet_1 FastMoving §¢ =

Area and Property Setup Alarm Activation Setup
Parameter Setup Rule Working Period
Object Type Supported e
Detect Type Fast Move [ +] [vHicon
Sensitiity Low 7} High | | Relay-out 2
Min Last Time 5 (s) [C] Send Email
Activation Speed | 30 kmvh [”] Snapshot

CopyTolALL  [~]

[9] Target Filter Daw | [ Gear

Min Size - Max Size

Figure 3-15
Please refer to the following sheet for detailed informaiton.
Parameter Function
Object type You can select an object type here. The default setup is all types.
supported
It is to set detection type. The default setup is “Fast move”. The rule is to detect the
Detect type . o :
fast moving object in the warning zone.
Sensitivity Here you can set the alarm activation sensitivity.

37



alhua .
TecHwoxoor Dahua Network Speed Dome Web 3.0 Operation Manual
Parameter Function
. . It is to set the min time between the object continuous movement and alarm
Min last time oo
activation.
Qgg;gﬂon It is to set the min speed here when an object can activate an alarm.

Target filter

set the target filter model in this scene. Click the button
selected target filter model.

Check the box here to enable this function and then click button

Clear

Draw

, you can

» you can remove

3.2.3.6 Perimeter Protection
The permiter protection interface is shown as in Figure 3-16.

@hua

Camera

Global Setup

3% B8 Select Scene | Scenet E’
* Network
e “ 1 Scene_1 Perimete;Prolecﬂo “ o -
Storage
System
Information
Area and Property Setup Alarm Activation Setup
z:;:cﬁt;;:;::;;ﬂ . Rule Working Period
Direction A>B 7] @ Record
~ ¥| Relay-out [l 2
@) Target Filter Daw | [ cex ] ] Send Emai
Min Size Max Size i anshos
Copy To |ALL E]
Refiesh || save
Figure 3-16
Please refer to the following sheet for detailed informaiton.
Parameter Function
Object e . .
J P You can select an object type here. The default setup is all types.
supported
Direction It is to set cross perimeter direction. The option includes: A->B. B->A. A<->B.
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Parameter

Target filter

Function

. . . Draw
Check the box here to enable this function and then click button » you can
set the target filter model in this scene. Click the button Elear » you can remove

selected target filter model.

3.2.3.7 Missing Object Detection
The missing object detection interface is shown as below. See Figure 3-17.

Global Setup Scene Setup Rule Setup Parameter @
| BB sclect Scene | Scene2 [=][__ Addrue |
~ WMEnable SN Rule Name Rule Type  Draw Delete
@ 1 Scene2 1 Missing ct:"ecl Dete u
Storage
System
Information
Area and Property Setup Alarm Activation Setup
e
Min Last Time 6 (s) - -
[v] Relay-out E] 2
[V] Target Filter Draw I | Clear [C] Send Email
Min Size = Max Size i tepstios
CopyTo|ALL E
Refresh “ Save
Figure 3-17
Please refer to the following sheet for detailed informaiton.
Parameter Function
Object e . .
J P You can select an object type here. The default setup is all types.
supported
. . It is to set the min time between the missing object occurrence and alarm
Min last time oo
activation.
. . . Draw
Check the box here to enable this function and then click button , you can
Target filter _ o _ Clear
set the target filter model in this scene. Click the button , you can remove

selected target filter model.

3.2.3.8 lllegal Parking
The illegal parking interface is shown as in Figure 3-18.
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@Jhua

Camera

Event
Storage
System

Information

Select Scene | Scene2 [~]
Enable SN Rule Name Rule Type Draw Delete

&1 Scene2_1 llegal Parking 06 o *

Area and Property Setup

Alarm Activation Setup
2:;::‘:";;;;::;“2 ’ Rule Working Period
Min Last Time 6 (s) [ZliRecard
S [V] Relay-out m 2
[9] Target Filter Draw | [ Cear [ Send Email
Min Size * Max Size (] ‘Snapshot
Copy To|ALL E|
Figure 3-18
Please refer to the following sheet for detailed informaiton.
Parameter Function
Object e . .
J P You can select an object type here. The default setup is all types.
supported
. . It is to set the min time between the illegal parking occurrence and alarm
Min last time

activation.

Target filter

Check the box here to enable this function and then click button Diaw , you can

set the target filter model in this scene. Click the button Clear , you can remove

selected target filter model.

3.2.3.9 Alarm Activation Setup
Alarm activation setup is shown as in Figure 3-19.
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Alarm Activation Setup

Rule Working Period Setup
W Record

M Relay-out m 2
" Send Email

I™ Snapshot

Copy To |ALL j Copy

Figure 3-19

Please refer to the following sheet for detailed informaiton.

Parameter

Function

Rule Working period

Here you can set rule arm and disarm period. Please click the Setup button to
set.

Check the box here so that the device can record when alarm activation

Record
occurred.
Check the box here so that the device can output an alarm when alarm
Relay output o
activation occurred.
e Check the box here so that the device can send out an email when alarm
activation occurred.
Send e-mail . L . .
e Please note current function is null when the device is offline, or IP conflict
occurred.
Check the box here so that the device can snapshot when alarm activation
Snapshot
occurred.
Copy Select a rule name from the dropdown list and then click button; you can

copy the alarm activation setup of current rule to the selected rule.

3.2.4 Parameter

The parameter interface is shown as in Figure 3-20.

41




alhua

TECHNOLOGY

Camera

Event
Storage
System

Information

VS e te

Dahua Network Speed Dome Web 3.0 Operation Manual
@Jhua

Scene Setup

Global Setup

Scene Scenet [~]

Detect Balance Compromise Mode [ ]
Sensitivity Low 1} High
Anti-Disturb Enable  [V]

Backlight Scene V]

Enable

Shadow Scene ¥l
Enable

Target Filter
Min Size

Max Size

IAdd Detect Regmn” Add Exclude |

Refresh | ! Save |

Figure 3-20

Please refer to the following sheet for detailed informaiton.

Parameter

Function

Scene

Please select a scene from the dropdown list you want to set.

Detect balance

There are three modes: compromise mode, omission detect less and error detect
less.

The level ranges from 1 to 10. The default setup is 5. The higher the sensitivity is,

Sensitivity the easier for the device to detect the low contrast object and small object. At the
same time, the error detect may become more.

Anti-

disturbance It is to control the random disturbance in the scene.

mode

Backlight scene
enable

Check the box here so that the device can have higher recognition capability in the
backlight scene.

Shadow scene
enable

Check the box here so that the device can have higher recognition capability in the
shadow scene.

Target filter

Draw

Click button
Clear

, you can set the target filter model in this scene. Click the

button

, you can remove selected target filter model.

region Click button , You can draw a detection zone.
Add exclued
region Click button L A& | you can draw the privacy mask (shield) zone.
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3.3 Network

3.3.1 TCP/IP
The TCP/IP interface is shown as in Figure 3-21.

@hua

Camera TCP/P
IVS Setup

Network

Host Name IPDome

Ethemet Card Wire(DEFAULT) =
> Connection Mode © Static ©' DHCP
> PPPoE .
» LS IP Version 1Pv4 =]
& [PAL IP Address 10 .15 . 89 100
> SMIP(Email) R e 2 o

> UPnP
> SNMP

Default Gateway 0 . 15 . 0 .

0
1
Preferred DNS Server. 8 8 8 . 8
> Bonjour
5 Alternate DNS Server & 8 8 . 8
> Multicast

Vi
3 802.1x Enable ARP/Ping to set P address service

> QoS Defaut || Refiesh || saw

Event

Storage

System

Information

Figure 3-21
Please refer to the following sheet for detailed information.
Parameter Function
Host Name It is to set current host device name.
Ethernet Card Please select the Ethernet port if the device has several

network cards.

Mode There are two modes: static mode and the DHCP mode.

® The IP/subnet mask/gateway are null when you select the
DHCP mode to auto search the IP.

® If you select the static mode, you need to set the IP/subnet
mask/gateway manually.

® Besides, IP/subnet mask/gateway and DHCP are read-
only when the PPPoE dial is OK.

Mac Address It is to display host Mac address. It is read-only.
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IP Version It is to select IP version. IPV4 or IPV6.
You can access the IP address of these two versions.
® Please note system needs to check the validity of all
IPv6 addresses. The IP address and the default gatew:
shall be in the same IP section. That is to say, the
specified length of the subnet prefix shall have the sa
string.
® When PPPoE function is enabled, the IP/subnet
mask/default gateway is read-only. You can not set or
restore default setup.
IP Address Please use the keyboard to input the corresponding number to

modify the IP address and then set the corresponding subnet
mask and the default gateway.

Default Gateway

It is the similar gateway of the IPv4. It shall not be left in blank.

Preferred DNS

DNS IP address. It is the similar DNS of the IPv4. It shall not be
left in blank.

Alternate DNS

Alternate DNS IP address. It is the similar DNS of the IPv4. It
shall not be left in blank.

Enable
ARP/Ping set
device IP
address service.

You can use ARP/Ping command to modify or set the device IP
address if you know the device MAC address.

Before the operation, please make sure the speed dome and
the PC in the same LAN. This function is on by default.

You can refer to the steps listed below.

Step 1: Get an IP address. Set the speed dome and the PC in
the same LAN.

Step 2: Get the physical address from the label of the speed
dome.

Step 3: Go to the Run interface and then input the following
commands.

arp —s <IP Address> <MAC>

ping —| 480 —t <IP Address>

Such as: arp -s 192.168.0.125 11-40-8¢-18-10-11
ping -1 480 -t 192.168.0.125

Step 4: Reboot the device.

Step 5: You can see the setup is OK if you can see there are
output information such as “Reply from 192.168.0.125 ...” from
the command output lines. Now you can close the command
line.

Step 6: Open the browse and then input http:// http://<IP
address>. Click the Enter button, you can access now.
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3.3.2 Connection
The connection interface is shown as in Figure 3-22.

@Jhua

Camera Connection

IVS Setup

Network

Max Connection

(1~20)

TCP Port ar777 (1025-65534)
> TCPIP
N UDP Port 37778 (1025-65534)
Connection
HTTP Port a0
> PPROE
5 DONS RTSP Port 554
> IP Filter [ HTTPs

> SMTP(Email) HTTPs Port

> UPnP

> SNMP
> Bonjour
> Multicast
> 8021x
> QoS
Event

Storage

System

Information

Figure 3-22
Please refer to the following sheet for detailed information.
Parameter | Function
Max It is the max Web connection for the same device. The value ranges from 1
connection | to 20. The default setup is 10.
TCP port | The value ranges from 1025 to 65535. The default value is 37777. You can
input the actual port number if necessary.
UDP port | The value ranges from 1025 to 65535. The default value is 37778. You can
input the actual port number if necessary.
HTTP port | The value ranges from 1025 to 65535. The default value is 80. You can
input the actual port number if necessary.
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RTSP port | ® Usually, the default value is 554. You do not need to input again if you
are using the default value. When you are using QuickTime (Apple
browser) or VLC play real-time video, you can use the following format
to play. The Blackberry also supports this function.

® Real-time monitor bit stream Url format. Please specify the channel
number, bit stream type in the Url if you are requesting real-time
monitor bit stream Rtsp stream media service. You still need to
provide user name or password if it has verification information.

® When you are using Blackberry phone to access, the bit stream mode
shall be H.264B, resolution is CIF and the audio shall be disabled.

® The Url format is shown as below:
rtsp://username:password@ip:port/cam/realmonitor?channel=1&subtype=0
You need to input the following items manually.
Username/password/IP/port/subtype.

The IP is device IP and the port default value is 554. You can leave it in
blank if it is the default value. The channel number begins with 1.

subtype: bit stream type, main stream is 0 (subtype=0) and extra
stream is 1 (subtype=1) .

You do not need to input the user name and password if you do not need
the verification. Such as:

Main stream: rtsp://ip:port/cam/realmonitor?channel=1&subtype=0

HTTPS It is to enable HTTPs communication service control. If you enable this
Enable function, you can use https://ip:port to login the device. In data encryption
protection mode, you can use https://ip to login if you are using the default
port.
HTTPS The HTTPs communication port value ranges from 1025 to 65535.
Port
Important

The value 0 to 1024 (excluding the default value of HTTP/RTSP/HTTPs), 1900, 3800, 5000, 5050, 9999,
37776, 37780-37880, 39999 and etc are the special ports value and they are not open for user to set.

3.3.3 ONVIF

ONVIF (Open Network Video Interface Forum) which describes the model, interface, data type of
network video and the mode of data interaction. The target of ONVIF standard is to realize a network
video frame protocol, which makes the network video products (including front end, record device)
produced by different manufacturers completed compatible.

ONVIF function is disabled by default.
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@hua

Camera Connection ONVIF

IVS Setu|
etup Authentication ) Enable @ Disable

> TCPIP Default
> PPPoE

> DDNS

> IP Filler

> SMTP(Email)

> UPnP

> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS
Event

Storage

System

Information

Figure 3-23

3.3.4 PPPoOE
The PPPOE interface is shown as in Figure 3-23.

Input the PPPoE user name and password you get from the IPS (internet service provider) and enable
PPPoE function. Please save current setup and then reboot the device to get the setup activated.

Device connects to the internet via PPPoE after reboot. You can get the IP address in the WAN from
the IP address column.

PPPOE is set to connect to the internet. You can get an account from your IPS (Internet service
provider), you can set here to dial to the interface. You can see the registered IP address in the
interface if your setup is right.

Please note, you need to go to the IP address item to view the device current device information.
You can access the client-end via this address.
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@Jhua

Camera PPPoE
IS SSow [] Enable
Network

Usemame
> TCPAP

Password
> Connection

> DONS
> IP Filter
> SMTP(Email)

» UPnP

> SNMP
> Bonjour
> Multicast
> 802.1x
> QoS
Event

Storage

System

Information
Figure 3-23

3.3.5 DDNS

The DDNS interface is shown as in Figure 3-24.

The DDNS is to set to connect the various servers so that you can access the system via the server.
Please go to the corresponding service website to apply a domain name and then access the system
via the domain. It works even your IP address has changes.

@lhua

Camera DDNS

[] Server Type CN399 DDNS [=]

Server Address
> TCPAP

Domain Name none
> Connection

Usemame
> PPPoE none
> IP Filter Update Period 10 Minute (1~500)
> SMTP(Email) Default H Refresh H
> UPnP
> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS

Event

Storage

System

Information

Figure 3-24
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Please refer to the following sheet for detailed information.

Parameter Function

Server Type You can select DDNS protocol from the dropdown list and then
enable DDNS function.

Server IP DDNS server IP address

Server Port DDNS server port.

Domain Name | Your self-defined domain name.

User The user name you input to log in the server.

Password The password you input to log in the server.

Update period | ® Device IP and service connection refresh period.
® The default setup is 10 minutes.

3.3.6 P filter

The IP filter interface is shown as in Figure 3-25.

You can enable IP filter function so that some specified IP user can access the speed dome.
You can add IP address or IP address section.

If you do not check the box here, it means there is on access limit.

@Jhua

Camera IP Filter

WS Trusted Sites
Trusted Sites

> TCPIP IP address IMAC address Modify Delete
» Connection
> PPPoE
> DDNS

IP Filter
> SMTP(Email)
> UPnP
> SNMP
> Bonjour i
> Mudticast Add IPIMAC
> BD2 1x

‘ Defauit || Refresh H Save

> QoS
Event

Storage

System

Information

Figure 3-25

3.3.7 SMTP (e-mail)
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The SMTP interface is shown as in Figure 3-26.

@hua

Camera SMTP(Email)
IVS Setup
Network

> TCPIP

SMTP Server

Port

[CJ Anonymity
> Connection
Usemame
> PPPoE
BT Password
> IP Filter Sencer
SMTP(Email) Authentication
> UPnP
Title
> SNMP
Mail Receiver
> Bonjour
> Multicast
> 802.1x
> QoS Interval
Event [ Health Mail

Storage

System

Information

none

25

anony mity
asee

none

None [=]

SD Message Attachment

0 Second (0~3600)

Update Period Second (1~3600)

[ Defaun || Refiesh || sawe

Figure 3-26
Please refer to the following sheet for detailed information.
Parameter Function
SMTP Server Input server address and then enable this function.
Port Default value is 25. You can modify it if necessary.
Anonymity For the server supports the anonymity function. You can auto
login anonymously. You do not need to input the user name,
password and the sender information.
User Name The user name of the sender email account.
Password The password of sender email account.
Sender Sender email address.
Authentication You can select SSL or none.
(Encryption
mode)
Title (Subject) Input email subject here.
Attachment System can send out the email of the snapshot picture once
you check the box here.
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Parameter Function

Mail receiver Input receiver email address here. Max three addresses.

Interval The send interval ranges from 0 to 3600 seconds. 0 means
there is no interval.
Please note system will not send out the email immediately
when the alarm occurs. When the alarm, motion detection or
the abnormity event activates the email, system sends out the
email according to the interval you specified here. This
function is very useful when there are too many emails
activated by the abnormity events, which may result in heavy
load for the email server.

Health mail Please check the box here to enable this function.

enable

Update period This function allows th'e system to send out the test email to

(interval) check the connection is OK or not. '
Please check the box to enable this function and then set the
corresponding interval.
System can send out the email regularly as you set here.

Email test The system will automatically sent out an email once to test
the connection is OK or not .Before the email test, please
save the email setup information.

3.3.8 UPnP

It allows you to establish the mapping relationship between the LAN and the public network.
Here you can also add, modify or remove UPnP item. See Figure 3-27.

In the Windows OS, From Start->Control Panel->Add or remove programs. Click the “Add/Remove

Windows Components” and then select the “Network Services” from the Windows Components Wizard.
Click the Details button and then check the “Internet Gateway Device Discovery and Control client” and
“UPnP User Interface”. Please click OK to begin installation.

Enable UPnP from the Web. If your UPnP is enabled in the Windows OS, the speed dome can auto

detect it via the “My Network Places”
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@Jhua

Camera UPnP
IVS Setup
N k

> TCPAP

[C] Enable Mode Manual Iz‘ Router State Mapping Failed
Port Mapping List

Service Name Protocol Internal Port External Port Status Modify
> Connection HTTP WebService: TCP 80 8080 Mapping Failed . i
> PPPoE TCP PrivService:TCP 3T 3riit Mapping Failed
> DDNS uDP PrivService:UDP 37778 37778 Mapping Failed
> IP Filter RTSP RTSPService TCP 554 554 Mapping Failed

> SMTP(Email)
UPnP
> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS
Event
Storage
System

Information

Figure 3-27

3.3.9 SNMP

The SNMP interface is shown as in Figure 3-28.

The SNMP allows the communication between the network management work station software and the
proxy of the managed device. Please install the software such as MG MibBrowser 8.0c software or
establish the SNMP service before you use this function. You need to reboot the device to activate the
new setup.

QLUE]

Camera SNMP
IVS Setup
N k

> TCPIP SNMP Port 161 (1~655385)

SNMP Version

[ SNMPv1 [-] SNMPv2 [-] SNMP 3

> Connection Read Community public
» PPPoE Write Community private

> DDNS Trap Address
> IP Filter

> SMTP(Email)
> UPnP

> Bonjour

Trap Port 162
[[] Keep Alive

> Multicast
> 802.1x
> QoS
Event

Storage

System

Information
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Figure 3-28
Please refer to the following sheet for detailed information.
Parameter Function
SNMP Port The listening port of the proxy program of the device. Itis a

UDP port not a TCP port. The value ranges from 1 to 65535.
The default value is 161

Read Community Itis a string. Itis a command_ between the manage process
and the proxy process. It defined the authentication, access
control and the management relationship between one proxy
and one group of the managers. Please make sure the device
and the proxy are the same.
The read community will read all the objects the SNMP
supported in the specified name. The default setup is public.
Write Community Itis a string. Itis a command' between the manage process
and the proxy process. It defined the authentication, access
control and the management relationship between one proxy
and one group of the managers. Please make sure the device
and the proxy are the same.
The read community will read/write/access all the objects the
SNMP supported in the specified name. The default setup is
write.
The destination address of the Trap information from the
proxy program of the device.
Trap port The destination port of thg Trap information from the proxy
program of the device. It is for the gateway device and the
client-end PC in the LAN to exchange the information. It is a
non-protocol connection port. It has no effect on the network
applications. It is a UDP port not TCP port. The value ranges
from 1 to 165535. The default value is 162.

Trap address

SNMP version ® th\?clzk SNMP v1, system only processes the information
of V1.

® Check SNMP v2, system only processes the information
of V2.

® Check SNMP v3, you can set account and password. You
need to set the corresponding account and password for
security verification when the server wants to access the
device. At the same time, the V1 and V2 option is null.

3.3.10 Bonjour

The Bonjour interface is shown as below. See Figure 3-29.

Bonjour is based on the multicast DNS service from the Apple. The Bonjour device can automatically
broadcast its service information and listen to the service information from other device.

You can use the browse of the Bonjour service in the same LAN to search the speed dome device and
then access if you do not know the speed dome information such as IP address.
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You can view the server name when the speed dome is detected by the Bonjour. Please note the safari
browse support this function. Click the “Display All Bookmarks: and open the Bonjour, system can auto
detect the speed dome of the Bonjour function in the LAN.

@Jhua

Camera Benjour

REEEL Enable

Server Name YZB4KZ027W00001
> TCPIP

> Connection Default

> PPPoE

> DDNS

> IP Filter

> SMTP{Email)

> UPnP

> SNMP
Bonjour

> Multicast

> 802.1x

> QoS

Event

Storage

System

Information

Figure 3-29

3.3.11 Multicast

The multicast interface is shown as in Figure 3-30.

Multicast is a transmission mode of data packet. When there is multiple-host to receive the same data
packet, multiple-cast is the best option to reduce the broad width and the CPU load. The source host
can just send out one data to transit. This function also depends on the relationship of the group
member and group of the outer.

Here you can set multicast address and port. You also need to go to Live interface to set the protocol as
Multicast.

54



@hua

INOLOGY

@lhua

Camera
IVS Setup
Network
> TCPIP
> Connection
> PPPoE
> DDNS
> IP Filter
> SMTP(Email)
> UPnP
> SNMP
> Bonjour

[ baicas |
> 802.1x
> QoS
Event
Storage
System

Information
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Multicast

Main Stream

Enable

Multicast Address 224 . . .4 |(224.0.0.0~239.255 255 255)

Port 40000 (1025~65529)

Sub Stream
Enable
Multicast Address

Port

Sub Stream 1
224 .01 . (224.0.0.0~239.255 255 255)

(1025-65529)

Figure 3-30

3.3.12 IEEE802

IEEE802.1X works standing for local and metropolitan area networks and port based network access
control protocol. It supports manual operation of the client to choose means of authenticating by which
to control it to access to the Local Area Networks or not. It supports the ability to authenticate, to
calculate fee, to ensure security and to maintain requirements. See Figure 3-31.

@hua

Camera

IVS Setup

802.1x

[7] Enable

3 Authentication PEAP
> TCPAP

Usemname IPDome

> Connection

Password ene

> PPPoE
> DDNS

> P Filter

> SMTP(Emai)
> UPnP

> SNMP

Default

> Bonjour
> Multicast
> QoS
Event

Storage

System

Information
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Figure 3-31

Please refer to the following sheet for detailed information.

Parameter Function

Authentication | PEAP (protected EAP protocol).

Username It needs the username to login, which is authenticated by the
server.
Password Please input password here.
3.3.13 Qos

The QoS interface is shown as below. See Figure 3-32.

Qos (Quality of Service) is network security mechanism. It is a technology to fix the network delay and
jam problem and etc. For the network service, the quality of service includes the transmission bandwidth,
delay, the packet loss and etc. We can guarantee the transmission bandwidth, lower the delay, and
reduce the loss of the data packet and anti-dither to enhance the quality.

We can set the DSCP (Differentiated Services Code Point) of the IP to distinguish the data packet so
that the router or the hub can provide different services for various data packets. It can select the
different queues according to the priority of the packets and select the bandwidth of the each queue. It
can also discard at the different ratio when the broad bandwidth is jam.

@Jhua

Camera QoS
IVS Setup
Network

Realtime Monitor 0

Command 0
> TCPIP

> Connection
> PPPoE

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Benjour
> Multicast
> 802.1x
Event

Storage

System

Information

Figure 3-32

Please refer to the following sheet for detailed information.
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Parameter Function

Real-time The data packet of the network video monitor.

monitor

Command The non-monitor packet such as device setup and search.
3.4 Event

3.4.1 Video detect
3.4.1.1 Motion Detect

The motion detect interface is shown as in Figure 3-33.

@Jhua

Camera Motion Detect

IVS Setup
Network

> Audio Detect Area

[C] Enable

Working Period

Anti-Dither

» Alarm

> Abnormality FEEr|

Storage Record Delay

System Relay-out
Information Alarm Delay
[C] Send Email
] PTZ

[C] Snapshot

Video Tamper

Setup
0 Second (0~100)
Setup
10 Second (10~300)
2
10 Second (10~300)
Default H Refresh H Save

Figure 3-33
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Figure 3-35
Please refer to the following sheet for detailed information.
Parameter Function
Enable You need to check the box to enable motion detection function.
Sensitivity There are six levels. The sixth level has the highest sensitivity.
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Parameter

Function

Region

* There are six levels. The sixth level has the highest sensitivity.

¢ Region: If you select motion detection type, you can click this
button to set motion detection zone. The light blue zones are
the valid motion detect area. All area are the valid motion detect
zone by default. You can use mouse to set invalid area.

¢ Do remember clicking OK button to save your motion detection
zone setup.

Working
Period

¢ Motion detection function becomes activated in the specified
periods. See Figure 3-34.

* There are six periods in one day. Please draw a circle to enable
corresponding period.

* Select date. If you do not select, current setup applies to today
only. You can select all week column to apply to the whole
week.

¢ Click OK button, system goes back to motion detection
interface; please click save button to exit.

Anti-dither

System only memorizes one event during the anti-dither period.
The value ranges from 0s to 100s.

Relay out

Enable alarm activation function. You need to select alarm output
port so that system can activate corresponding alarm device when
alarm occurs.

Please note the relay output number here is for reference
only. The alarm output number may vary due to different
series products.

Alarm Delay

System can delay the alarm output for specified time after motior]
detect alarm ended. The value ranges from 10s to 300s.

Record
channel

System auto activates motion detection channel to record once
motion detect alarm occurs (working with motion detection
function). Please note you need to go to Storage-> Schedule to
set motion detect record period and go to Storage->Record
control to set current channel as auto record.

Record Delay

System can delay the record for specified time after motion detect
alarm ended. The value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert
you when alarm occurs and ends.
PTZ * Here you can set PTZ movement when alarm occurs. Such as
go to preset x when there is an alarm.
* The event type includes: preset, tour and pattern and etc.
Snapshot It is snapshot activation function.
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Area | X}

7 e s | Region " =0

Name | Region3

Sensitivity (=) - { (3 55

Threshold =)~ O ~(Z) 10

| Remove Al || Delete I(OrRighthick)

| Save | I Cancel |

Figure 3-36

Different colors represent different areas; each area can set different detection area, which can be
irregular and discontinuous. If the monitoring range of the device is very large, it can divide the big
range into several areas to enhance the result of motion detect.

Parameter Note

Default name is Region0 . Regionl . Region2 . Region3, it also can be

Name .
customized.

The sensitivity of the brightness change, for the same brightness change, the
Sensitivity bigger sensitivity is, the easier it will be to generate motion detect; each area can
set different sensitivity. Range is 0~100, suggested 30~70.

It is to detect the relationship between the object and the area. It will generate
Threshold motion detect when the lower limit percentage of moving object area covering
resho detection area reaches the set area threshold; each area can set different area

thresholds. Ranging from 0~100, suggested 0~10.

Red line means triggering motion detect, green line means not triggering motion

Oscillogram detect.

3.4.1.2 Video Masking
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The video masking interface is shown as in Figure 3-36.

QLUE

Camera Motion Detect

IVS Setup
Network

[C] Enable

13714

» Audio Detect

Record

» Alarm
Relay-out

> Abnormality
Storage Alarm Delay
System [C] Send Email
Information O P12

[] Snapshot

Working Period

Record Delay

Video Tamper

10 Second (10~300)

[z

10 Second (10~300)

Defaut || Refiesh || sawe

Figure 3-36

Please refer to the following sheet for detailed information.

Parameter

Function

Enable

You need to check the box to enable video masking function.

Sensitivity

There are six levels. The sixth level has the highest sensitivity.

Working
Period

¢ Video masking function becomes activated in the specified
periods.

® There are six periods in one day. Please draw a circle to enable
corresponding period.

e Select date. If you do not select, current setup applies to today
only. You can select all week column to apply to the whole
week.

¢ Click OK button, system goes back to motion detection
interface; please click save button to exit.

Anti-dither

System only memorizes one event during the anti-dither period.
The value ranges from 0s to 100s.

Relay out

Enable alarm activation function. You need to select alarm output
port so that system can activate corresponding alarm device when
video masking alarm occurs.

Please note the relay output number here is for reference
only. The alarm output number may vary due to different
series products.

Alarm Delay

System can delay the alarm output for specified time after video
masking alarm ended. The value ranges from 10s to 300s.
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Parameter Function
Record System auto activates motion detection channel to record once
channel video masking alarm occurs (working with motion detection

function). Please note you need to go to Storage-> Schedule to
set motion detect record period and go to Storage->Record
control to set current channel as auto record.

Record Delay

System can delay the record for specified time after video
masking alarm ended. The value ranges from 10s to 300s.

Email If you enabled this function, System can send out email to alert
you when alarm occurs.
PTZ * Here you can set PTZ movement when alarm occurs. Such as
go to preset x when there is an alarm.
* The event type includes: preset, tour and pattern and etc.
Snapshot It is snapshot activation function.

3.4.2 Audio Detect
@Jhua

Camera
IVS Setup
Network
Event

> Video Detect

» Alarm

> Abnormality
Storage
System

Information

Audio Detect

[C] Enable Input Abnormal

[C] Enable Intensity Change

Sensitivity =@ O 50
Threshold - 9 @ 50
Working Period Setup
Anti-Dither 0 Second (0~100)
Record
Record Delay 10 Second (10~300)
Relay-out II‘ 2
Alarm Delay 10 Second (10~-300)
[C] Send Email
[ PTZ
[7] Snapshot
Default__ [ Refresh || saw
Figure 3-37
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Parameter Note
Enable Input Check “Enable Input Abnormal”, it will trigger alarm when it detects audio input
Abnormal abnormal.
Enable Check “Enable Intensity Change”, it will trigger alarm when it detects the audio
Intensity intensity change exceeds the threshold.
Change
Sensitivity 1~100 level adjustable, only when the volume change of input sound surpasses the
volume of continuous environment, then it can be judged as audio abnormity when
the value is smaller. Users need to adjust according to the actual environmental
test.
Threshold 1~100 level adjustable, it can be used to set the intensity of filtered environmental
sound. If the environmental noise is louder, then it needs to set the value higher.
Users need to adjust according to the actual environmental test.
Working ® This function becomes activated in the specified periods. Click setup to open
Period working period menu to set.
® There are six periods in one day. Please draw a circle to enable corresponding
period.
® Select date. If you do not select, current setup applies to today only. You can
select all week column to apply to the whole week.
® Click OK button, system goes back to motion detection interface; please click
save button to exit.
Anti-Dither System only memorizes one event during the anti-dither period. The unit is second.
The value ranges from 0s to 100s.
Record Check it and so when alarm occurs, system will auto record. You shall set record
period in Storage>Schedule and select auto record in record control interface.
Record Delay | System can delay the record for specified time after alarm ended. The value ranges
from 10s to 300s.
Relay-out Enable alarm activation function. You need to select alarm output port so that
system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended. The value
ranges from 10s to 300s.
Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends.
PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to preset x
when there is an alarm.
® The event type includes: preset, tour and pattern.
Snapshot Activate snapshot function.
3.4.3 Alarm
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The alarm activation interface is shown as in Figure 3-37.
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Network
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Storage
System

Information

Relay Activation
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Figure 3-37

Please refer to the following sheet for detailed information.

Parameter

Function

Enable

You need to check the box to enable this function.

Working
Period

¢ This function becomes activated in the specified periods.

® There are six periods in one day. Please draw a circle to enable
corresponding period.

e Select date. If you do not select, current setup applies to today
only. You can select all week column to apply to the whole
week.

¢ Click OK button, system goes back to motion detection
interface; please click save button to exit.

Anti-dither

System only memorizes one event during the anti-dither period.
The value ranges from 0Os to 100s.

Sensor type

There are two options: NO/NC. From NO to NC, system enables
alarm. From NC to NO, system disables alarm.

Relay out

¢ Enable alarm activation function. You need to select alarm
output port so that system can activate corresponding alarm
device when alarm occurs.

® Please note the relay output number here is for reference
only. The alarm output number may vary due to different
series products.

Alarm Delay

System can delay the alarm output for specified time after alarm
ended. The value ranges from 10s to 300s.

64



am@ya Dahua Network Speed Dome Web 3.0 Operation Manual

Parameter Function
Record System auto activates motion detection channel to record once
Channel alarm occurs (working with motion detection function). Please

note you need to go to Storage-> Schedule to set current channel
as general record.

Record Delay | System can delay the record for specified time after alarm ended.
The value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert
you when alarm occurs and ends.

PTZ ¢ Here you can set PTZ movement when alarm occurs. Such as
go to preset x when there is an alarm.

* The event type includes: preset, tour and pattern.

Snapshot You need to input capture channel number so that system can
backup motion detection snapshot file.

3.4.4 Abnormality
It includes five statuses: No SD card, capacity warning, SD card error, and disconnection, IP conflict

and illegal access.

Note:
The device which supports SD card has the abnormity function of “NO SD Card”, “Capacity Warning”

and “SD card error”.

ELUE]

Network lllegal Access

Camera SD Card

ISES Event Type No SD Card [~]
Network
[C] Enable
Event - -
V| Relay-out
> Video Detect v E
Alarm Delay 10 Second (10~300)

> Audio Detect
[[] Send Email

» Alarm
Abnormality

Storage

System

Information

Figure 3-38
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@Jhua

Camera SD Card
IVS Setup

Network lllegal Access

Event Type SD Card Eror [+]
Network
[F] Enable
Relay-out 2
> Video Detect v II]
Alarm Delay 10 Second (10~300)

> Audio Detect

3 Alam [C] Send Email

‘Abnormality

Storage

System

Information
Figure 3-39

@hua

Camera SD Card

Network lllegal Access

WS ez Event Type Capacity Wamning [=]
Network
[7] Enable
+ Video Detect Capacity Limit 10 %(0~99)
» Audio Detect Retay-out m 2
3 Alam Alarm Delay 10 Second (10~300)
Abnormality [C] Send Email
Storage ‘ Default || Refresh H Save
System
Information
Figure 3-40
Parameter Note
SD card abnormity alarm event includes: no SD card, capacity warning, SD card
Event Type
error.
Enable Check it to enable SD card abnormity alarm.
Check it to enable alarm activation output interface, it can activate
Relay out

corresponding alarm output device when alarm occurs.

Alarm delays a certain period of time after alarm ended, the unit is second,
ranging from 10s to 300s.

Alarm Delay Note:

No SD card, capacity warning, SD card error, alarm delay starts from the
beginning of alarm.

Check it to send email to users when alarm occurs, users can set email address

Send emall in “Network > SMTP”.
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Parameter Note
SD Card It can set the remaining capacity of SD card; alarm will occur when the
Capacity Limit remaining capacity of SD card is less than the percentage.

When device is offline or IP conflicts, the abnormal alarm is similar with case of SD card error.

@hua

Camera SD Card Network llegal Access

IVS Setu|
P Event Type Disconnection [=]
Network
[C] Enable
Event
Record
> Video Detect
Record Delay 10 Second (10~300)
» Audio Detect
7l
3 Alarm Relay-out m 2
Abnormality Alarm Delay 10 Second (10~300)
Storage | Defaut || Relesh || sae
System
Information

Figure 3-41

When login password keep been wrong for a few times, illegal access alarm occurs. This operation is
similar to SD card error. Allow login error times as when it exceeds this limit, user account will be locked.

@Jhua

Camera SD Card
IVS Setup
Network

lllegal Access

[C] Enable

Login Error 3 time (3~10)
Event
Relay-out 2
> Video Detect Y II]
Alarm Delay 10 Second (10~300)
> Audio Detect

5 Alam [7] Send Email

Abnormality

Storage

System

Information
Figure 3-42

3.5 Storage

3.5.1 Record schedule and snapshot schedule

In these two interfaces, you can add or remove the schedule record/snapshot setup. See Figure 3-41.
There are three record modes: general (auto), motion detect and alarm. There are six periods in one
day. Please make sure you have enabled the corresponding record mode in the Setup->Storage-
>Conditions.
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You can view the current time period setup from the color bar.
® Green color stands for the general record/snapshot.

® Yellow color stands for the motion detect record/snapshot.
® Red color stands for the alarm record/snapshot.

@Jhua

Camera Record Schedule Snapshot Schedule Holiday Schedule

IVS Setu
P General M [7] Motion Alarm B
Network
2 4 6 8 10 12 14 16 18 20 22 24
Event
P
3 Destination ey Setup
» Record Control Wednesday
System Thursday Setup
Information Friday
P
e
Heliday Satup
Defaut || Refesn || sawe
Figure 3-41

3.5.2 Destination

The destination interface is shown as in Figure 3-42.

It is to set the storage mode of the speed dome record file or snapshot pictures. There are two options:
local storage/FTP. You can only select one mode. System can save according to the event types. It is
corresponding to the three modes (general/motion/alarm) in the Schedule interface. Please check the
box to enable the save functions.

@hua

Camera Path
IVS Setup
Network

Record Snapshot

Event Type Scheduled Motion Detect Alarm Event Type Scheduled Metion Detect Alarm
Exeat Local Local
FTP i ] ] FTP ] O ]

> Schedule

» Record Control

System

Information

Figure 3-42

Please refer to the following sheet for detailed information.
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Parameter | Function

Event It includes: general, motion detect and alarm.
Type

Local It is to save in the SD card.

FTP It is to save in the FTP server.

The local interface is shown as in Figure 3-43. Here you can view local SD card information. You can
also operate the read-only, write-only, hot swap and format operation.

@Jhua

Camera

IVS Setup - Used Capacity/Total Capacity
Network

Event

> Schedule
» Record Control
System

Information -

ReadOnly || Read&wile || Hotswap || Refresh Format

Figure 3-43

The FTP interface is shown as in Figure 3-44. You need to check the box to enable the FTP function.
When network disconnect occurred or there is malfunction. Emergency storage can save the
record/snapshot picture to the local SD card.

@Jhua

Camera Path
IVS Setup
Network

Enable

Server Address
Event
Paort 21 (0~65535)

3 Schedul User Name anonymity
Schedule

» Record Control
System Emergency (Local)

Password

Remoate Directory share

Information Default | | Refresh | ‘ Save

Figure 3-44

3.5.3 Record control
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The record control interface is shown as in Figure 3-45.

@hua

Camera Record Control

IVS Setup
Network

Event
Storage

> Schedule
» Destination

System

Information

Pack Duration

Pre-event Record 5]
Disk Full
Record Mode

Record Stream

30 Minute (1~120)

Second (0~5)

Overwrite =]
@ Auto () Manual ) Off
Main Stream =]
Default || Refresh H Save

Figure 3-45
Please refer to the following sheet for detailed information.
Parameter | Function
Pack Here you can select file size. Default setup is 60 minutes.
Duration
Pre-record | Please input pre-record value here.
For example, you can input 4 here so that system can read the
previous four seconds video before the alarm occurrence from the
buffer and record the 4 seconds video in the file.
Please note, if there is no record when alarm record or motion detect
record occurred, system can record the N seconds’ video before the
event occurrence in the file.
Disk Full There are two options: stop recording or overwrite the previous files
when HDD is full.
® Stop: Current working HDD is overwriting or current HDD is full,
it will stop record.
® Overwrite: Current working HDD is full; it will overwrite the
previous file.
Record There are three modes: Auto/manual/close.
Mode
Record Bit | YOU can select main stream or extra stream.
Stream
3.6 System
3.6.1 General

The general interface includes the general setup and the date/time setup.

3.6.1.1 General

The general interface is shown as in Figure 3-46.
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@lhua

Camera General
IVS Setup
Network

Language
Event

Device Name

Date&Time

YZBAKZ027WO0001
English

Video Standard PAL

Storage

> Account
> PTZ Setiings
» Default

> Import/Export
> Auto Maintain
» Upgrade

Information

Figure 3-46

Please refer to the following sheet for detailed information.

Parameter | Function

Device It is to set device name.

Name

Video This is to display video standard.

Standard

Language You can select the language from the dropdown list.
Please note the device needs to reboot to get the modification
activated.

3.6.1.2 Date and time
The date and time interface is shown as in Figure 3-47

@Jhua

Camera General
IVS Setup
Network

Date Format

Time Format
Event

Time Zone
Storage

Current Time
System
» Account DST Type
> PTZ Seftings Start Time
> Default End Time

> Import/Export
> Auto Maintain NTP Server
> Upgrade Port

Information

Update Period

Date&Time

YYear-Month-Day [~]
24-Hour-based System [~
GMT+03:00 []
2015 - 04 - 03 09 30 - 35 Sync PC
@ Date O Week

Jan [=] 1 [+]| o0 : oo :
Jan [=][2 [=] oo : o0 :

[C] Synchronize with NTP

clock.isc.org
123
30 Minute (0~30)
Default H Refresh H Save
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Figure 3-47
Please refer to the following sheet for detailed information.

Parameter | Function

Date format | Here you can select date format from the dropdown list.

Time There are two options: 24-H and 12-H.

Format

Time zone | The time zone of the device.

System It is to set system time. It becomes valid after you set.

time

Sync PC You can click this button to save the system time as your PC current
time.

DST Here you can set day night save time begin time and end time. You
can set according to the date format or according to the week
format.

NTP You can check the box to enable NTP function.

NTP server | You can set the time server address.

Port It is to set the time server port.

Update It is to set the sync periods between the device and the time server.

period The update function is null if the value is 0.

3.6.2 Account

Note:

® [For the character in the following user name or the user group name, system max supports 15-digit.
The space in the front or at the end of the string is null. The valid string includes: character, number,
space and underline.

® The max user amount is 20 and the max group amount is 8. You can add or delete user group.

® The factory default setup includes two levels: user and admin. .User management adopts
group/user modes. The user name and the group name shall be unique. One user shall be included
in only one group.

3.6.2.1 User name

In this interface you can add/remove user and modify user name. See Figure 3-48.

Once you check the box here to enable anonymous login function, you can go to the preview interface

after you input address in the browser to login.
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@hua

Camera
IVS Setup
Network
Event

Storage

> General
Account

> PTZ Settings

> Default

> Import/Export

> Auto Maintain

> Upgrade

Information

Dahua Network Speed Dome Web 3.0 Operation Manual

Account

[] Anonymous Login

User Name

Group

No. Group Name Remark Modify Delete
1 admin admin admin s account r =
Authority List
Live Playback Record Control Backup PTZ Account
Alarm Log Search Clear Log Upgrade Auto Maintain General
Video/Audio Schedule/Destination Network Abnomality Video Detect PTZ Settings
Default/lmport/Export Conditions. VS

Add user: Itis to add a name to group and set the user rights. See Figure 3-49.

Here you can input the user name and password and then select one group for current user.

Please note the user rights shall not exceed the group right setup.
For convenient setup, please make sure the general user has the lower rights setup than the admin.

Add User

User Name
Password
Confirm Password
Group

Remark

Authority List

o

admin

All

Live

Playback

Record Control

Backup -

Save | |

Cancel
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Figure 3-49

Modify user
It is to modify the user property, belonging group, password and rights. See Figure 3-50.

Modify password
It is to modify the user password. You need to input the old password and then input the new password

twice to confirm the new setup. Please click the OK button to save.
For the user of the account rights, he can modify the password of other users.

Modify User (X
User Name 868888 B
(] Modify Password
Group
Remark
Authority List All
Live i
Playback
Record Control
Backup -
Save Cancel
Figure 3-50

3.6.2.2 Group
The group management interface can add/remove group, modify group password and etc.

The interface is shown as in Figure 3-51.

74



amlroya Dahua Network Speed Dome Web 3.0 Operation Manual

@Jhua

Camera Account

ISESep [C] Anonymous Login
(s User Name Group
Event Group Name [o— Modify Delete
Storage admin administrator group s =]
2 user user group Ka —]
» General
Account
> PTZ Seftings
> Default
> Import/Export
> Auto Maintain -
> Upgrade Authority List
Information Live Playback Record Control Backup PTZ Account
Alarm Log Search Clear Log Upgrade Auto Maintain General
VideolAudio Schedule/Destination Network Abnomality Wideo Detect PTZ Settings
Default/import/Export Conditions VS
Figure 3-51

Add group: Itis to add group and set its corresponding rights. See Figure 3-52.
Please input the group name and then check the box to select the corresponding rights. It includes: live
playback, record control, backup, PTZ control, user management and etc.

Add Group X}
Group
Remark
Authority List ] Al
[] Live I_‘E‘_I
] Playback

[ Record Control
[ Backup -

Save | | Cancel

Figure 3-52

Modify group

Click the modify group button, you can see an interface is shown as in Figure 3-53.
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Here you can modify group information such as remarks and rights.

Medify Group X}
Group user |E|
Remark user group
Authority List ] Al
Live N

El
Playback

] Record Control
[[] Backup -

Save | | Cancel

Figure 3-53

3.6.3 PTZ
3.6.3.1 Network PTZ
The network PTZ interface is shown as in Figure 3-54.

@hua

Camera
IVS Setup
Network

Event

Storage

System
» General
> Account
> Default
> Import/Export
> Auto Maintain

> Upgrade

Information

Figure 3-54

Please refer to the following sheet for detailed information.

Parameter | Function

Select the corresponding dome protocol.

Protocol
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3.6.3.2 Analog PTZ

@Jhua

Camera Analog PTZ
IVS Setup
Network

1

Baudrale 9600 [+]
Event

Data Bit

Storage

Stop Bit

> General ol

> Account

» Default

> Import/Export
> Auto Maintain

» Upgrade

Information

Figure 3-57
Parameter Note
Address It is set as the address of the corresponding Speed Dome, it is 1 by default.
Baud rate It is to select the Baud rate for camera, default is 9600
Data Bit It is 8 by default
Stop Bit Itis 1 by default
Parity It is to set parity mode of the protocol, it is none by default.
3.6.4 Default

The default setup interface is shown as in Figure 3-55.
Please note system can not restore some information such as network IP address.
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@hua

Camera
IVS Setup
Network

Event

Storage

» General
> Account
» PTZ Settings
> Import/Export
> Auto Maintain
> Upgrade

Information

Figure 3-55

3.6.5 Import/Export
The interface is shown as in Figure 3-56.

@Jhua

Camera Import/Export
IVS Setup
Network

Backup Path

Event dnall

Storage

» General
> Account
> PTZ Settings
> Default

> Auto Maintain

> Upgrade

Information

Figure 3-56

Please refer to the following sheet for detailed information.

Parameter | Function
It is to import the local setup files to the system.

Import

Export It is to export the corresponding system setup to your local PC.

3.6.6 Auto maintenance
The auto maintenance interface is shown as in Figure 3-57.
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Here you can select auto reboot and auto delete old files interval from the dropdown list.
If you want to use the auto delete old files function, you need to set the file period.

@hua

Camera Auto Maintain
IVS Setup
Network

Auto Reboot Tuesday

[[] Auto Delete Old Files
Event

Storage Manual Reboot

TR [ Refiesh |[ sae
» General

> Account
> PTZ Settings
> Default
> Import/Export

> Upgrade

Information

Figure 3-57

3.6.7 Upgrade

The upgrade interface is shown as in Figure 3-58.

Please select the upgrade file and then click the update button to begin firmware update.

Important

Do not turn off the device power, disconnect the device, reboot or shutdown the device during
the update period.

Please reboot the device if you update the improper program, otherwise some function module
of the device may become null!

@hua

Camera
IVS Setup
Network

Select Firmware File

Event

Storage

System
> General
> Account
» PTZ Settings
» Default
> Import/Export
» Auto Maintain

Information

Figure 3-58
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3.7 Information

3.7.1 Version

The version interface is shown as in Figure 3-59.

Here you can view system software version, WEB version, release date and etc. Please note the
following information is for reference only.

@Jhua

Camera Version
IVS Setup
Network

DH-SD-6A58240-HNI-L

Device Type
Software Version 2.420.0000.1.T.4011.9ANR, build : 2015-03-28

Event

WEB Version 3.2.1.257630
Storage

ONVIF Wersion 241
System

PTZ Version 2.02.32 RHIRFG

Camera Version 01.04.08

> Log
> Online User

SN YZB4KZ027TW00001

Copyright 2015 All Rights Reserved

Figure 3-59

3.7.2 Log
Here you can view system log. See Figure 3-60.

@hua

Camera Log
IVS Setup

Start Time | 2015 - 04 - 02 09 30 27 EndTime | 2015 - 04 - 03
Network
Event
No. Log Time User Name Event
Storage -

System

3 Version

> Online User

Detailed Information

4411 P MGoTo »

Figure 3-60
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Please refer to the following sheet for log parameter information.

Parameter | Function

Type Log types include: system operation, configuration operation, data
operation, alarm event, record operation, and user management, log
clear.

Start time Set the start time of the requested log.

End time Set the end time of the requested log.

Search You can select log type from the drop down list and then click search
button to view the list.
You can click the stop button to terminate current search operation.

Detailed You can select one item to view the detailed information.

information

Clear You can click this button to delete all displayed log files.

Backup You can click this button to backup log files to current PC.

3.7.3 Online User
The online user interface is shown as in Figure 3-61.
Here you can view online user name, group name, IP address and login time.

@Jhua

Camera Online User

VS Setup User Local Group IP Address User Login Time
Network 1 admin admin 10.18.116.45 2015-04-03 08:53:51

Event
Storage

System

» Version

> Log

Figure 3-61

81



am@ya Dahua Network Speed Dome Web 3.0 Operation Manual

4 Alarm

Click alarm function, you can see an interface is shown as in Figure 4-1.

Here you can set device alarm type and alarm sound setup. When the specified alarm occurred (you
have subscribed), system can record the corresponding alarm information on the right pane of the alarm
list.

Alarm Type No. Time Alarm Type Alarm Channel
[ Motion Detect [ Disk Full

[ pisk Emror [Cvideo Tamper

[7] External Alarm [T legal Access

[ Audio Detect

Operation

[C] Prompt

Alarm Tone

Il Play Alarm Tone

Figure 4-1
Please refer to the following sheet for detailed information.
Type Parameter Function
Alarm Motion detect System alarms when motion detection alarm
type occurs,
Disk full System alarms when disk is full.
Disk Error System triggers alarm when disk error happens.
Video Tamper System alarms when video is tampering.
External alarm Alarm input device sends out alarm.
lllegal Access System alarms when the times of password error is
over the set number.
Audio Detect System alarms when audio detect occurs.
Operation | Prompt System automatically pops up alarm dialogue box.
Alarm Audio When alarm occurs, system auto generates alarm
audio audio. The audio supports customized setup.
Path Here you can specify alarm sound file.
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5 Log out

Click log out button, system goes back to log in interface. See Figure 5-1.
You need to input user name and password to login again.

@Jhua

Usemame: l admin |

Figure 5-1

Note:

This manual is for reference only. Slight difference may be found in user interface.
All the designs and software here are subject to change without prior written notice.

All trademarks and registered trademarks are the properties of their respective owners.

If there is any uncertainty or controversy, please refer to the final explanation of us.
Please visit our website for more information.
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TECHNOLOGY

Dahua Technology Co., Ltd

Address: No0.1199 Bin’an Road, Binjiang District, Hangzhou, China.
Postcode: 310053

Tel: +86-571-87688883

Fax: +86-571-87688815

Email:overseas@dahuatech.com

Website: www.dahuatech.com
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